
 

University of Bristol I T Services document acc-29 

 

          Using and designing    
Access 2010  

databases 

Practical workbook 
 

 

 

 

 

 

 

 

 

 

 

 

Aims and Learning Objectives 

This course provides participants with the basic skills necessary to develop a simple Access 
2010 database.  

The core learning objectives for this course are to: 

 gain an understanding of necessary relational database concepts; 

 create and use tables and set relationships between tables; 

 import external data; 

 create and use queries to manipulate the data; 

 create data entry forms; 

 create reports to present data in an attractive format using grouping and sorting options; 

 create mailing labels. 

Note: this document will be of little or no use to those using Access 2003 or earlier 
versions; those using Access 2007 will find that the Microsoft Office Button has been 
replaced by a File tab in the Ribbon and that many Ribbon items have moved, mostly to 
new locations within the same Ribbon tab, but should have no real problems. 
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Prerequisites 

Before attending this course you must be familiar with other MS Office 2007 or later 
applications, such as Word 2007/2010 and Excel 2007/2010. 

Introduction 

Access 2007/2010 is the University’s recommended database product. This 
document covers the basic operations required to create an Access 2010 database. 

Access is a relational database management system (RDBMS) that lets you store 
data according to subject. These subjects have set relationships with each other, 
making it easy to bring the related data together. 

Data used in example databases on this course is fictitious. We would remind you 
that if you store personal information of individuals on a database, you should be 
aware of the legal requirements under the Data Protection Act. Further information 
about the Data Protection Act can be obtained from the Registrar’s Office. 

If you process restricted University data on a database, you should be aware of 
your responsibilities toward keeping this data safe and secure. See the Information 
security website (www.bristol.ac.uk/infosec) for further information.  
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Task 1 Opening the Student2010 database 

Objectives To open the Student2010 database, select the correct security setting and look 
around the work environment. 

Comments Databases created in earlier versions of Access can be opened in Access 2010, 
though there may be problems with buttons and other objects no longer working.  

 

Opening Access 2010 

On opening Access, the Getting Started with Microsoft Office Access window is 
displayed. From here you can create a new database, access pre-created templates 
(not recommended) or, as we want to do, open a pre-existing database file. 

 
Figure 1 - Getting Started with Microsoft Office Access window 

1.1 To open the Student2010.accdb database: 

 Click on Open…, and navigate to C:\Training\Access\Access 2010 current 
course. 

 Double-click on Student2010.accdb to open the database. 

Note    A security warning now appears. If you select the wrong options, functionality, such 
as buttons and wizards, will not work (if you choose the wrong option, simply close 
the database and reopen it, this time selecting the correct option as below). 

1.2 To select the correct security option: 

 

Figure 2 – select Enable Content 

 On the Security Warning message box, select Enable Content (Figure 2). 

 If a further Security Warning opens asking if you want to make the file a “Trusted 
Document”, select No. 

 Look at the open database taking particular notice of the File tab (which now 
replaces the Office 2007 Button), the tabbed Ribbon with available (context-
sensitive) commands and the Navigation pane but do not click on anything yet 
(Figure 3). 
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Figure 3 – the Access workspace (you will have different objects showing in the 
Navigation Pane) 

Note    The Navigation pane partially takes the place of the Database window in Access 
2003 and earlier versions, letting you navigate between and open database objects.  
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Task 2 The Navigation pane and setting tabbed display 

Objectives To view the database objects in the Navigation pane and to set a tabbed display. 

Comments The Navigation pane takes the place of the Database window in pre-2007 versions. 
The default is for objects to open on top if each other, which can make things 
difficult as you have to remember which objects you have open at any given time. 
Setting a tabbed display lets you easily see which objects you currently have open.  

 

Object Function 

Tables Tables are the ‘heart’ of a database. They define and store 
data about particular subjects, e.g. candidates. Each 
candidate has their details stored in a separate row (each 
row is known as a record). The columns contain details about 
each candidate, e.g. name, address, date of birth, etc. 
(columns are known as fields). 

Queries Queries let you view just the information you want to see, 
rather than having to look at records and fields you are not 
interested in. 

Forms Forms are designed primarily for data entry and 
manipulation. Inputting data directly into a table can be 
awkward, so forms can make this easier. You can use a form 
to enter data into more than one table at a time. 

Reports Reports are designed to be printed rather than viewed on 
screen. A report is a collection of data that is summarised 
and formatted according to your specifications. 

Macros Macros contain a set of commands to automate a task. 
Macros are covered on the Access buttons and macros 
course (CC2ABM). 

 

2.1 To view all database objects in the Navigation pane: 

 
Figure 4 – select All Access Objects at the bottom of the menu 

 Click on the downward arrow on the Header bar on the Navigation pane and select 
All Access Objects (if not already selected as default). 
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 In the Tables section of the Navigation Pane, double-click on Students to open it 
and then double-click on Faculties. 

 Notice that the second object opens on top of the first, so that you cannot see the 
original object. 

Note    If both objects open showing a tab including the objects’ names, then ignore the 
next part of this task as you already have tabbed display set! 

2.2 To set tabbed object display as default: 

 Click on the File tab and click on Options. 

 Click on Current Database and under Document Window Options, select Tabbed 
Documents. 

 
Figure 5 – select Tabbed Documents 

 A message will tell you that you need to close the database for the change to take 
effect, so click on OK. 

 Click on the File tab and select Close Database. 

 Still in the File tab, double-click on Student2010.accdb to reopen the database. 

 You will need to enable the database again, so click on Enable Content and 
choose No if a further security warning appears. 

Note    Although the default file suffix for an Access 2010 database is .accdb, it is perfectly 
possible to open up .mdb files created in earlier versions of Access. 

 Again, in the Tables section of the Navigation Pane, double-click on Students to 
open it and then double-click on Faculties; notice that these now have a tabbed 
display at the top of each table. 

 Right-click on the Faculties tab and select Close from the menu that opens, then 
click on the X in the top, right-hand corner of the Students table to close that table 
as well. 
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Task 3 Working with tables 

Objectives To gain familiarity with the database tables by viewing, sorting, entering and 
modifying data, plus searching and navigating between records. 

Comments This database is used throughout the course with the work from many tasks being 
built upon in later stages of the course. 

 

What should I know about tables before I start? 

Question Answer 

Can I just have one 
table in my 
database? 

Access databases must contain at least one table, 
however, in most instances, two or more related tables 
may be required to store your data efficiently. 

How are tables 
linked? 

If you use more than one table, these may be linked 
together by creating relationships between them. 

Why do I have to 
build the tables first? 

Tables are created before other objects because all other 
objects, such as forms, queries and reports, are based on 
one or more tables or the data in them.  

What is a field? Fields relate to columns in a table. Fields are individual 
items of data such as last name or date of birth. The same 
field can appear in more than one table in a database – 
and this is how those tables are linked. 

What is a record? Records relate to rows in a table. A record is a set of data 
about one particular item. For example, one record about a 
person could contain their title, initials, last name, address, 
city, postcode and date of birth. 

Viewing data in a table 

The Students table contains students’ details, the Subjects table contains course 
details and the Faculties table contains a faculty list. Relationships link the tables so 
you could, for example, print out a list of all the students taking Botany. 

Note    There are other ways than covered here to view data - some will be covered later. 

3.1 To view data in the three tables: 

 In the Tables section of the Navigation Pane, double-click on Subjects to open it in 
Datasheet View (also called Table View in Access texts). 

 Look at the information in each row and column, and look at the field names at the 
top of the columns (you can widen columns the same way you would in Excel).  

 Close the Subjects table by right-clicking the header and open the Faculties table. 

 Identify the different data types and try the various hyperlinks to see what they do 
(some may not work due to ever-changing security restrictions in the training room). 

 Open the Students table. Note that tabbed display enables you to quickly look at 
each table without closing. 

 Close the Faculties table and leave just the Students table open. 
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3.2 To navigate around the Students table: 

 Use the TAB key (or left and right ARROW KEYS) to move across the rows, so 
displaying the fields that are initially out of view. 

 Use the up and down ARROW KEYS to move up and down the table.  

Note    The Datasheet View shows all the information entered into all the fields in the table - 
in a large database the sheer amount and layout of data on the screen can be 
overwhelming. The following tasks show some simple methods for sorting, 
navigating and finding records. 

Sorting, navigating and finding records 

Sorting records 

3.3 To sort records based on a field: 

 Click on LastName. 

 In the Home tab of the Ribbon, click on the A-Z icon to sort the names in 
ascending order, then click on the Z-A icon to sort in descending order. 

Note    You can sort on more than one field by holding down the Shift key whilst selecting 
fields, though the fields must be next to each other in sort order of left to right. 

Navigating through records 

The navigation buttons (these are also called video buttons) are situated in the 
bottom, left-hand corner of the table window. The current record number is 
displayed between the navigation buttons. The total number of records in the table is 
shown to the right of the navigation buttons. 

3.4 To navigate through records: 

 
Figure 6 - navigation buttons 

 Click on > to move one record forward, then click on < to move one record back. 

 Click on >| to move to the last record in the table, then click on |< to move to the first 
record in the table. 

 Click on >* to create a new record. 
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Finding records 

3.5 To find records containing specific data: 

 In the Home tab of the Ribbon, click on the Find icon to open the Find and 
Replace dialogue box. 

 
Figure 7 - find and replace dialogue box 

 In the Find What field type Chelwood Village. 

 Under Look in select Current Document, and under Match select Any Part of 
Field. 

 Click on the Find Next button then close the dialogue box by selecting Cancel. 

Entering and modifying data 

Warning!     Data can be entered directly into a table - although entering and modifying data 
directly into a table is the least user-friendly method of data entry and variations in 
the way data is entered are more likely to occur. Forms are better for entering data. 
They let you concentrate on one record at a time and make it easier to select data 
from dropdown lists. 

3.6 To add a new record to the Students table: 

 
Figure 8 – the StudentNumber field for a new record contains (New) 

 Click on the New Record button to go to a new, empty record. Note that the student 
number currently says (New). 

 Add a new student record of your own using the TAB key to move from one field to 
the next.  

 Notice that (New) is automatically changed to a unique number once you start to 
enter data into the record. 

 When you get to the Subject field add a known subject code (e.g. F800).  

Note    Changes made to data are saved as soon as you tab to the next record unless you 
have entered an incorrect value in which case you will not be able to exit that field. If 
you change the design of tables, forms, queries or reports, however, you are 
prompted to save changes, as you will see later. 
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3.7 To change the subject code for an existing student: 

 Use the scroll bars or Find button to find the record for Susan Pamela Osborne. 

 
Figure 9 – a row highlighted by clicking on the Selector bar 

 Click on the Selector bar to the left of the StudentNumber field (this is the narrow 
column to the left of the table) to highlight the whole line. 

Note    Clicking on the Selector button highlights the whole record so that you can copy or 
delete it if necessary.  

 Click in the Subject field, change L500 to L400, then close the Students table. 
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Task 4 Create a new table and set the primary key 

Objectives To create a new table in Design View and assign the primary key. 

Comments In this task you will create a new table for adding course marks for each student. 

 

What do I need to know about creating tables before I start? 

Question Answer 

What do I see 
in Design 
View? 

Design View for creating tables has three main columns: Field 
Name; Data Type; and Description. The first two must be used 
for every field you create. The last is optional but useful. 

What is the 
Description 
column for? 

Text entered here appears in the status bar at the bottom of the 
table when you enter a field (and on forms that were created 
since the description was added). This basically lets you add 
context-sensitive text, for example, which values should be 
entered in a specific field.  

What do I 
need to know 
about field 
names? 

 There are many words that cannot be used as field names in 
Access, such as date or name. These are reserved words. 
Access can lose data from fields named with a reserved word 
or can get very confused when these are used in queries. 

 Field names are not case sensitive, e.g. TITLE and title are 
the same as far as Access is concerned.  

 Do not use symbols in field names (underscores are ok). Use 
only alphanumeric characters. Spaces should be avoided. 

What are the 
different data 
types for? 

 Text - holds up to 255 characters. 

 Memo - holds a large body of text. 

 Number - holds numeric values. 

 Date/Time - holds dates and/or times. 

 Currency - holds numeric values as money. 

 AutoNumber - automatically creates unique, sequential 
numbers (i.e. for primary keys). Note that if you delete 
records, then there will be gaps in the sequence. 

 Yes/No - limits a field to one of two values. 

 OLE Object - holds pictures, sounds, MSOffice objects. 
Linking is more efficient than embedding objects. 

 Hyperlink - links to web addresses, Access objects, 
MSOffice objects, etc. 

 Lookup Wizard - creates dropdown boxes for entering pre-
defined data from either a list or from another table 

More information can be found in the reference section in 
Using and designing Access databases - useful reference 
information (acc-2). 
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Create a new table to hold marks information 

Note    Do not use a wizard to create tables – building in Design View is the best way. 

4.1 To create a new table: 

 
Figure 10 – table options under the Create tab 

 In the Create tab of the Ribbon, select Table Design. 

 
Figure 11 - designing a table 

 Enter the information from the following table, using the dropdown list to select Data 
Type (click on the Field Size or Format box in the Field Properties section below 
the grid to enter the required field properties in the fourth column of the table below). 

Field Name Data Type Description  
(to the right of field 
name) 

Field Properties 
(at the bottom of 
the screen) 

StudentNumber Number This identifies the 
student 

Long Integer 

SubmitDate Date/Time The date the work 
was submitted 

Format = Short 
Date 

Title Text The title of work (max 
30 characters) 

Field size=30 

Type Text Essay, exam, etc. Field Size =10 

Mark Number Enter an integer Integer 

CreditPoints Number Enter an integer Byte 

Comment Text Any extra information Field Size = 50 

 

Warning!     StudentNumber must have the data type Number and be specified as Long 
Integer even though it was an Autonumber in the Students table. The linking field 
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to an Autonumber must always be Long Integer because Autonumbers are Long 
Integer format. 

Add the primary key 

What do I need to know about primary keys before I start? 

Question Answer 

What is a 
primary key? 

You must set up a primary key (a unique index field) before 
you save your new table. The primary key contains unique 
values so the database can identify each individual record.  

Can you have 
more than one 
primary key? 

There can be only one primary key index per table (though the 
primary key may be made up of more than one field). The 
primary key is used in creating relationships between tables. 

Can I leave the 
primary key 
empty? 

No. Good primary key fields are order numbers and 
identification (ID) numbers – or other fields that do not often 
change. It is not a good idea to use last name fields as primary 
key fields as there may be several Smiths or Browns. 

What happens if 
I don’t allocate a 
primary key to a 
table? 

If you don’t allocate a primary key when saving a table, 
Access offers to create one: this is an AutoNumber field that 
automatically assigns the next consecutive number each time 
you add a record. Although this is often useful, sometimes you 
will want to choose your primary key from existing fields. If you 
choose not to have a primary key then you will not be able to 
use that table as a lookup. 

 

4.2 To create a primary key for the new table: 

 
Figure 12 – both fields must be selected as above before clicking the Primary key icon 

 Select the StudentNumber row then hold the CTRL key and select the Title row 
(Figure 12).  

Note    You can only tell that the first field is selected because the Selector bar is 
highlighted as circled above. Otherwise only the last selected field is very obviously 
selected. Earlier versions of Access were a bit more intuitive here! 

 Click on the Primary Key icon on the toolbar and notice that the two fields 
now have a small key icon to the left of the Field Name.  
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Figure 13 – both fields should show key icons 

 Click the Save icon (above the File tab), name the table Marks then close it. 

Note    Why are there two fields to make up the primary key? In this table, each 
student’s mark is uniquely identified by a combination of these two fields: the same 
student can submit lots of different titles and lots of different students can submit the 
same title. However, no student is able to submit the same title twice. This applies a 
degree of validation. If only the StudentNumber field was chosen as primary key 
then each student would only be able to submit one piece of work, and if only the 
date was chosen then only one piece of work could be submitted per day. 

Adding data to the Marks table 

4.3 To enter some marks into your new table: 

 From the Table section of the Navigation Pane, double-click on the Marks table to 
open it in Datasheet View and enter the following data.  

Student 

Number 

Submit 

Date 

Title Type Mark Credit 

Points 

Comment 

1 1/3/11 Death on the 
Nile 

Essay 75  Late 

1 1/3/11 Dial M for 
Murder 

Essay 95  Very 
inventive 

1 1/6/11 English Part 1 Exam 55  Needs resit 

1 1/11/11 LANG10031 Module 50 10  

 

 If you have time, enter some more records with the same titles as above for student 
2 and student 3. Give them different marks and comments (Figure 14). 

 Try adding some dates to SubmitDate in different ways, e.g. Sept 1, 1 Sept 
(without year), Sept 2002, 1/1/02, 1/1/50 and watch what happens to the date. 

 Enter 1/1/29 and see how the year is represented – do the same with 1/1/30. 

 Try entering 30 February then close the table. 

 
Figure 14 – add the data for student number 1 and add some extra data for other 
students 
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Task 5 Relationships within a database 

Objectives To create a relationship between the newly-created Marks table and the related 
table in the student database. 

Comments A well-designed relational database eliminates unnecessary duplication of data by 
relating individual tables to other tables in the database. 

 

What do I need to know about relationships before I start? 

Note    Only two types of relationships can be created in a relational database: see the table 
below. To create a relationship the related fields must have the same data type.  

Relationship Description 

one-to-many 
(1:∞) 

A relationship is created where each record in a table can be 
associated with 0, 1 or more records in another table. This is the 
most common relationship used in relational databases. The 
primary key is at the ‘1’ end of the relationship. 

one-to-one 
(1:1) 

Each record in the primary table can be associated with only one 
record in the related table (and both ends must have the same 
primary key). In this case the related fields must be the primary 
keys of both tables. You may find this useful if you need to add 
your own data to student views.  

Looking at the current relationships in the Student database 

5.1 To look at the current relationships in the Student database: 

 
Figure 15 – the Relationships icon in the Database Tools tab 

 In the Database Tools tab of the Ribbon, click on the Relationships icon.  

 
Figure 16 – the Relationships window 

 Look at the existing relationships between the three tables (explained below).  

 

 



Using and designing Access 2010 databases (acc-29)  

 

 14  

Relationship in Student 
database 

Description 

Subjects (1): Students (∞) This relationship means that one subject can be 
studied by 0, 1 or more students but that each 
student can study only one subject.  

Faculties (1): Students (∞) Similar to above, this relationship means that one 
faculty can have 0, 1 or more students, but that 
each student can only belong to one faculty. 

Creating a relationship between students and marks 

Relationship to create Description 

Students (1): Marks (∞) This relationship means that each student can be 
given many marks, but that each record in the 
Marks table can only be assigned to one student. 
Each mark must belong to an existing student. 

 

5.2 To add the Marks table to the Relationships window: 

 Click on the Show Table icon, double-click on the Marks table (Figure 17) 
then close the Show Table dialogue box. 

 
Figure 17 – the Show Table dialogue box 

5.3 To create the relationship between the Marks table and the Students table: 

 In the Students table, click and hold the mouse button down on StudentNumber. 

 Drag from StudentNumber in the Students table to StudentNumber in the Marks 
table and let go of the mouse button. This opens the Edit Relationships dialogue. 

5.4 To set the relationship: 

 Tick Enforce Referential Integrity - this makes sure that you cannot enter marks 
for a student that does not already exist in the Student table. This is indicated by the 
∞ symbol. 

 Tick Cascade Update Related Fields - this means that if you have to alter a 
student’s number in the Students table, then that number will be automatically 
changed in every record in the Marks table in which it appears. 

Warning!     Do not select Cascade Delete Related Records. This option has its uses, but it 
can also cause loss of data. For example, if you had this option set on a relationship 
between Faculty and Student tables and you needed to delete one faculty, this 
would cause all the linked students to be deleted from the database as well.  
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Figure 18 – the Edit Relationships dialogue box 

 Click on Create to finalise the relationship. The ‘1’ end of the relationship should be 
by the Students table and the ‘∞’ next to the Marks table (Figure 19). 

 
Figure 19 – the new relationship 

 Close the Relationships window and select Yes to save the changes. 

Looking at linked data in table view (sub-datasheet) 

5.5 To view the new sub-datasheet in the marks table: 

 Open the Students table and notice the + symbol that now appears in the first 
column (because Marks is related to this table). 

 Click on the + in Agatha Christie’s record to show the marks you added in the 
previous task. If you added data for students 2 and 3, look at their marks too. 

Note    The + changes to – once the sub-datasheet is open.  

 Click on the – to close the Marks sub-data sheet then close the Students table. 

 
Figure 20 - linked data 
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Task 6 Importing data from a non-Access source 

Objectives To import existing data into an Access table. 

Comments Before you start entering reams of information, find out if the information is already 
available – student and staff data, for instance is available via the DataHub. Even if 
it is in a different format, you can still import that data into a new table, add it to an 
existing one or link it so that it is always up-to-date. This prevents typos and saves 
data entry time. 

 

What do I need to know about importing data before I begin? 

Access can import and export data in many different formats, such as from delimited 
text files (the format used in Word Mail Merge) and Excel spreadsheets.  

Note    Word documents cannot be imported directly and must be saved as txt. Also, any 
data formatting, such as italics and bold, will be lost on import. You can only import 
one line per record. 

 

Figure 21 – example of a comma-delimited text file 

Question Answer 

Why do some delimited 
text files have double 
quotes around each field? 

If any field contains a comma, e.g. “24, The Drive”, 
the double quotes are obligatory to show that the 
comma is part of the data and not a field separator. 

What if the text file 
includes field names in 
the first column? 

If the first line of the text file contains field names 
separated by commas (as in the example), it is easy 
to create a new Access table by importing the text file 
– Access then uses these as field names. Access 
assigns the most applicable data types.  

What if the text file does 
not include field names? 

If the file does not contain field names or you want to 
specify your own data types, you can create a table 
in Access containing the appropriate field names first 
and then import the data into it. Otherwise your field 
names will be Field1, Field2, etc. which you can 
change later to something more meaningful. 

Can I append existing 
data directly into an 
existing Access table? 

Provided that the number of fields (excluding any 
autocounter field) in the text file corresponds to the 
number of fields in the Access table, the data may be 
appended directly – otherwise you can import into a 
new table and create an append query.  
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Importing data to a new table 

In this task you use a comma delimited text file, including field names and double 
quotes, to create a new table. 

6.1 To choose which file to import: 

 Click the External Data tab of the Ribbon and select Text File from the Import & 
Link section (Figure 22). 

 
Figure 22 – select to Import the external data 

 In the Get External Data window, click on Browse and navigate to the file 
C:\Training\Access\Access 2010 current course\Org.txt. 

 Make sure that Import the source data into a new table in the current database 
is selected and click OK to start the Import Text Wizard. 

6.2 To select the correct options for importing org.txt: 

 Select Delimited on the first screen, followed by Next. 

 Make sure that there is a tick next to First Row Contains Field Names (Figure 23). 

Note    If a message says “The first row contains some data that can’t be used for valid 
Access names…”, don’t worry, just select OK. If you are importing from Excel, this 
can cause extra fields to be added – ignore the message and accept the new fields. 

 Make sure that Delimiter is set to Comma and set Text Qualifier to " (the wizard 
shows the changes made to the example text as you do this) and choose Next. 

Warning!     The quotes should have vanished as per Figure 23. 

 
Figure 23 – you should set the import options as above 

 You don’t need to make any changes in Field Options, so just click Next. 

 Select Choose my own primary key and select OrgCode (Figure 24).  



Using and designing Access 2010 databases (acc-29)  

 

 18  

 
Figure 24 – make sure that you select OrgCode as the primary key 

 Choose Next then click on Finish (don’t save import steps if prompted). 

6.3 To check that the table has imported correctly: 

 In the Navigation Pane, double-click on Org to check it then close the table. 

6.4 To add a relationship between the Org and Subjects tables: 

Note    Refer to Task 5 if you have forgotten how to create a relationship. 

 In the Database Tools tab of the Ribbon, select Relationships and add a 
relationship between OrgCode in Org and OrganisationCode in Subjects – the 
primary and linked field names are different, but are the same data type. 

 
Figure 25 – with the Org table and relationship added, your relationships should now 
look similar to this 

 Close the Relationships window and save changes. 

 Open the Org table and click on the + next to the record for aero. 

 In the sub-table that opens, click on the + next to H400 to view students attached. 

 Close the sub-tables and then close Org. 

Importing dates 

Warning!     For important information on potential problems when importing dates, refer to the 
Access 2007 user support website at 
http://www.bristol.ac.uk/is/learning/office/access2007/training/using/import.html 
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If you have time 

The spelling dictionary and AutoCorrect definitions are shared across 
all Microsoft Office applications so that user additions only need to 
be added once, no matter which Office application is being used.  

Spell Check wizard 

1.1 To use the spellchecker on the Org table: 

 Open the Org table. 

 In the Home tab of the Ribbon select Spelling (this spell checks the 
whole table). 

 Click Ignore ‘OrgName’ Field to just spell check the org_name field. 

 Select Ignore a few times just to see how the spell check function 
works. 

 Click Cancel and close the Org table. 

Autocorrect 

AutoCorrect automatically corrects text that you frequently mistype, 
and can automatically replace abbreviations with long names. For 
example, you can create an entry uob for University of Bristol. 
Whenever you type uob followed by a space or punctuation mark, 
this will automatically be replaced with University of Bristol.  

 Click on the File tab and select Options. 

 Select Proofing followed by the AutoCorrect Options... button. 

 Select Replace text as you type if not selected. 

 In the Replace box, enter uob. 

 In the With box, enter University of Bristol. 

 Click Add followed by OK and then click on OK again. 

Note    AutoCorrect will not correct text that was typed before you selected 
the Replace text as you type check box. 

 Try it out by opening a form or a table and typing uob. Remember 
that you will have to choose a field that has a large enough text field 
to accept the 21 characters in University of Bristol – MiddleName 
in the Students table will do. 

Warning!     If you actually want UoB to appear, you will have to deselect 
Replace text as you type. Once you have entered UoB and saved 
the record, you will need to re-select Replace text as you type. 
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Task 7 Customising a table 

Objectives To make the table display data in the way that you want it to. 

Comments Save changes with each single modification, otherwise troubleshooting is difficult. 

 

Customisation 
type 

Description 

Format You can specify formats for most data types: you can use 
format symbols to specify any type you want, such as: 

> forces text to display in upper case and < in lower case 

mmm yyyy displays date as Jan 2002 

Validation Rule Set rules to determine whether or not data entered is valid, 
such as only allowing specific text strings or number ranges. 

Validation Text You can set a message which appears if someone tries to enter 
data that does not obey a validation rule. This is recommended 
because the systems-generated text is not very enlightening! 

Default Value If you specify a default value, this value will be automatically 
entered when you start to enter data into a new record. By 
default, numeric values always default to zero. Be careful to 
clear this value if you want it to be null – having 0 instead of a 
null value can be misleading in calculations such as finding 
averages (‘0’ is a value, whilst ‘null’ means that there is nothing 
in the field – that the value is unknown). Changing the default 
does not affect current records. 

Required If you set this to Yes, then you must enter data in this field. 

 

Note    For further information on non-standard formats use the on-line help and Access 
query language elements (acc-4) - see the Related Documentation section. 

7.1 To create a validation rule that limits data entry to the integers 1 through to 7: 

 Open the Students table in Design View. 

 In the Field Name column click on Faculty so that it is highlighted. 

 
Figure 26 – Validation Rule for the Faculty field (note that Faculty is highlighted) 

http://www.bristol.ac.uk/is/selfhelp/documentation/docs-current.htm#acc-r4
http://www.bristol.ac.uk/is/selfhelp/documentation/docs-current.htm#acc-r4
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 Enter Between "1" And "7" next to Validation Rule (the quotes are not needed if it 
is a numeric field - if you forget to add the quotes you will get a warning when you 
save the table saying that the expression is incorrect or too complex). 

7.2 To create a validation rule that limits data entry to Bristol or Bath in a field: 

 In the Field Name column click in the Town field. 

 Enter “Bristol” or “Bath” next to Validation Rule (Figure 27). 

7.3 To add validation text: 

 Add suitable text for each of the above rules next to Validation Text (Figure 27). 

 
Figure 27 – Validation Rule and Validation Text for the town field 

7.4 To set a default value: 

 
Figure 28 – set the Default Value 

 In the Field Name column click in the Town field and set Default Value to Bristol. 

 Set Required to Yes so that all new records must include a value in this field. 

Note    Make sure that the default value is allowed by any validation rules you may have 
added – e.g. don’t assign a text default value to a numeric field! 

 Click on Datasheet View (when prompted to save the table, select Yes). 

 Two warning messages appear – just select Yes on both of them. 

Note    The messages warn you that existing data does not correspond to the new 
Validation Rule set in 7.2 – however, the data already in the table is not changed. 

 In Datasheet View enter data to test your new rules and then close the table.  
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Task 8 Create single and multi-table select queries 

Objectives To create queries to view specific data based on stated criteria. 

Comments Queries are more powerful than using the Find or Sort options. 

 

What do I need to know about queries before I start? 

Question Answer 

What are 
queries? 

Queries let you find, sort and change data according to specified 
criteria. They also let you look at data from different tables into a 
single query and can use functions and expressions. Queries 
can be used as the basis of forms, so that you can update 
multiple tables at the same time when entering data in just one 
form. They can also be used as the basis for creating reports.  

Why might I 
want to use 
a query? 

Queries are used to ask questions to find specific data so that 
only required records and fields are extracted. For example, you 
might want to create a query to view a list of students in surname 
order, showing their course name and their course tutor. The 
query will show only this data in table format so that you can print 
it out and/or save the query for future use.  

Are all 
queries the 
same? 

There are two main types of queries: Select queries (which is the 
default type) show requested views of data in the tables but do 
not change this data (though you can edit the results of the query 
the same as in a table); Action queries actually do something to 
the data in the tables, such as altering or deleting specific data, 
depending on which type of action query you have built. 

Are there 
any query 
wizards? 

There are several wizards that can make creation of certain 
types of queries easier.  

Select queries using simple criteria 

8.1 To create a new query and add the required fields: 

 
Figure 29 – the Query Design icon available via the Create tab 

 Select the Create tab of the Ribbon and select Query Design to open the Query 
By Example (QBE) grid and the Show Table window. 

Note    You can also base a query on a query. 

 Double-click on Students followed by Close to shut the Show Table window. 

 In the Students table, double-click on LastName, FirstName, Sex, DOB and 
Faculty in turn. 
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Figure 30 – this is how the QBE grid should look 

8.2 To add simple text criteria: 

 
Figure 31 - Jones criteria in the LastName field 

 In LastName click on the Criteria box and enter Jones (Figure 31).  

 Click out of the column and notice that Access adds two sets of speechmarks (“”) 
meaning that it recognises this as text. 

 Select the Datasheet View icon in the Ribbon to see the query results. 

 Return to Design View and change Jones to Smith or Jones. 

 Look at Datasheet View to see the result of your query. 

 
Figure 32 – Like s* criteria in the Lastname field 

 Return to Design View and change Smith or Jones to s* then click out of the 
column and notice that Access adds Like and puts quotes around s* (Figure 32).  

Note    Using the * operator is known as a wild card search. 

 Check the result of your query and return to Design View.  

8.3 To add simple numeric and date criteria 

 Remove the criteria from the LastName field. 

 In Faculty enter >5 into the Criteria box and then check the result of your query. 

 Back in Design View, remove the criteria from the Faculty field. 

 
Figure 33 – Between query in a Date/Time field 
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 In DOB enter between 1/1/69 and 31/12/72 into the Criteria row (Figure 33).  

 Click out of the column and notice that Access adds hashes (#) – this confirms that 
Access recognises these as date strings – and check the result of your query. 

8.4 To add simple true/false criteria: 

 Remove the criteria from DOB and add PaidFees to the grid.  

 In PaidFees enter yes and check the results, then change Yes to no and repeat. 

Finding blank fields and sorting data 

8.5 To find blank fields: 

 
Figure 34 – the Is Null criteria 

 Remove all criteria from the above query. 

 Add Add3 to the grid and check the query results - many Add3 values are blank. 

 In Add3 type Is null and view the results (Figure 34). 

 Change Is Null to is not null, view the result, then return to Design View. 

8.6 To see the students in alphabetical order: 

 
Figure 35 – select Ascending from the Sort dropdown list 

 Remove the criteria from the above query. 

 In LastName click on Sort, select Ascending and view the query results. 

Saving a query 

8.7 To save the query: 

 Click the Save icon next to the Office Button and save as MyTestQuery. 

 
Figure 36 – the query is now available in the Navigation Pane 

 Note that MyTestQuery now exists in the list of available queries in the Navigation 
Pane. You can run this at any time by double-clicking on it here. 
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Using more than one criteria 

Note    All criteria on the same line must be true to retrieve a record. If you want to give two 
criteria, either of which may be true, then put one of the criteria on the or line. 

8.8 To practice creating queries with more than one criteria: 

 Open the MyTestQuery in design view and list all the men (code is 1). 

 List all the women and everyone (male or female) with the surname Smith.  

 Check the results and then close the query without saving changes. 

Queries using more than one table 

8.9 To create a query using more than one table: 

 
Figure 37 – query using two related tables 

 Create a new query and add the Students and Subjects tables (Figure 37).  

 Add LastName, FirstName and Subject to the grid from the Students table. 

 Add CourseName from the Subjects table and sort by CourseName. 

 View the results of your query then return to Design View and close it, saving it with 
an appropriate name. 

 

 

 

 

 

If you have time... 

1.2 To practice multi-table queries: 

 Create a query to list all students in the Faculty of Medicine who 
are studying Dentistry (this query needs three tables). 

1.3 To display subjects where there are no students:  

 In the Create tab of the Ribbon, select Query Wizard. 

 Click Find Unmatched Query Wizard and OK. 

 Select Table: Subjects, followed by Next. 

 Select Table: Students as the referring table, followed by Next. 

 Make sure that Subject is highlighted on each side, and click 
Next, then select CourseName, Next and Finish. 

 After viewing the query results look at the query in Design View to 
see how it has achieved this result. 



Using and designing Access 2010 databases (acc-29)  

 

 26  

Task 9 Create a query to calculate totals 

Objectives To create a query that groups information and calculates totals. 

 

9.1 To create a query that calculates how many students are in each year: 

 Create a new query and add the Students table. 

 Add YearNumber to the QBE grid. 

 Add YearNumber again in the next column so it appears twice. 

 Click on the Totals icon and notice that a Total line has been added to the 
QBE grid with the default Group By.  

 Leave the first YearNumber column as Group By and sort in ascending 
order so that Access groups first years followed by second years, etc. 

 In the second YearNumber column, replace Group By with Count (Figure 38).  

 
Figure 38 – creating a query to calculate totals 

Note    This tells Access to look at the unique values of year and then count how many of 
each there are. Note the other calculations available from the dropdown list.  

 View the results of your query (Figure 39). 

Note    It is preferable to count on the primary key since if there is no value in Year that 
record would not be shown in the count. 

 
Figure 39 – Datasheet View showing the results of the query in Figure 38 

9.2 To view the year with the most students: 

 Return to Design View and remove the sort from YearNumber (the Group By one). 

 In the YearNumber column with Count, sort in descending order. 

 View the query results then close and save the query with an appropriate name. 
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Task 10 Create a query with an expression 

Objectives To create a query that uses existing fields to create new fields. 

Comments Expressions can be used in queries (and also on forms and reports) and are very 
useful for manipulating existing data held within the database. 

 

Creating a numerical expression 

10.1 To create a numerical expression: 

 Create a new query based on the Faculties table. 

 Add the FacultyName and Fees fields. 

 Add the Fees field a second time. 

 In the first Fees field, change Fees so that it says Fees*2. 

 Click anywhere in the grid and notice square brackets appear around the Fees field 
name and Expr1: (the default field name for an expression) is added to the 
beginning of the field (Figure 40). 

 
Figure 40 – how the above numerical expression should look before renaming Expr1 

Note    The square brackets [ ] identify the beginning and end of a field name and this is 
particularly needed if there is a space in the name of the field. 

 Look at the query results. 

10.2 To change the name of your new expression: 

 In Design View change Expr1: to Double fees: (do not delete the colon). 

 Look at the query results (Figure 41) then close the query (save it if you want to). 

 
Figure 41 – how the column header should look after renaming Expr1 

Creating a text expression 

10.3 To join first and last names together into a single field: 

 Create a new query based on Students and add FirstName, LastName and DOB. 

 Click in the Field box of the blank column next to DOB. 

 Enter [FirstName] & “ “ & [LastName] (leave a space between the two sets of 
speech marks) and click somewhere in the grid so that Expr1: is added to the 
beginning of the field (Figure 42). 
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Figure 42 – concatenating (joining) two text fields together 

Note    This expression uses the concatenation operator & which joins fields together. The 
quotation marks mean “I contain text” , and you must enter two sets, not just one 
set. The text we’ve entered here is a space between the two halves of the name. 

 Change Expr1: to Fullname: (do not delete the colon) and view the query results. 

 Return to Design View and remove Firstname, un-tick the Show box in LastName 
and sort in ascending order by LastName. 

 View the query results (Figure 43) and save the query as FullName. 

 
Figure 43 – how the Fullname column should look when run 

 Create a new query based on the Students table experiment with concatenating 
various fields. 

If you have time... 

Task 25 and Task 26 provide additional query practice – the first provides 
some easy practice, whilst the second is a bit more difficult.  

These tasks will be especially useful for researchers and those needing to 
analyze their data. Try these tasks if you have time to spare after this task 
or after the following query tasks. 
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Task 11 Create an Update query 

Objectives To create a query that changes data in the underlying table. 

Comments You will alter the contents of the Sex field from 1 to Male and from 2 to Female. You 
can only update one table at a time. It is easier to update one field at a time so that 
you can make sure that the right data is being updated. It might be a good idea to 
make a copy of the table before you make any changes. 

 

What do I need to know about action queries before I start? 

Question Answer 

What is an 
action query? 

Action queries are created in the same way as select queries, 
but action queries modify the data. By using an action query, 
you can make changes to many records in one operation.  

What types of 
action queries 
are there? 

 Update queries change the data in a specified group of 
records - these are very useful for making changes to a large 
number of records in one go.  

 Append queries append data to a table from the same or 
another table.  

 Make-Table queries let you create new tables in the same or 
another database.  

 Delete queries let you delete data from tables.  

Can I run an 
action query 
by mistake? 

Action queries can be dangerous because they can change your 
data. There may be action queries in a pre-existing database. If 
the icon next to the query name is different to those next to 
normal select queries, find out what it does before running it. 

What is the 
safest way to 
check what an 
action query 
will do? 

If you want to run a previously-created action query, look at it in 
Design View first and check what will be altered by looking at 
Datasheet view before running the query.  

 

Warning!     Before you try to create an Update query, it is a good idea to look at the design of 
the table that is to have data changed to check that the data type of the field will 
allow the change (e.g. you will not be able to update a Number field with text), and 
that the field size is big enough to allow the update; if not, it will be truncated. 

11.1 To change the entry in the Sex field from 2 to Female: 

 Create a new query and add the Students table. 

 Select Update from the Query Type section of the Ribbon and notice that 
an extra row has been added to the QBE grid with the label Update To.  

 Add the Sex field to the QBE grid and type 2 in the Criteria box. 

 Enter Female in the Update to box (Figure 44). 
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Figure 44 – the QBE grid should look like this 

 View the values that be will changed by selecting Datasheet View (do not select the 
Run icon). You should see a column of approximately fifty rows with 2 in each. 

 Return to Design View and select Run, followed by Yes to confirm.  

 Click on the View toggle again. No values will be shown because the value 
2 no longer exists in the Sex field – they have all been changed. 

 To view the query results, double-click on Students in the Tables section of the 
Navigation Pane.  

 Close the Students table and close the query, saving it as UpdateQuery.  

11.2 To practice using an update query: 

 Open UpdateQuery in Design View. 

 Change all the men in the table (men are designated as 1) to Male. 

 Check the Students table then close both table and query, saving changes to the 
query as you close it. 

Note    If you accidentally change both males and females to the same sex, how you can 
correct this – and what problems might you encounter along the way? 

11.3 To distinguish an Update query from other types of query: 

 Look for UpdateQuery in the Navigation Pane. 

 Note that it is shown in the query listings with a different icon which distinguishes it 
from a normal query. 

 
Figure 45 – it is always a good idea to look at action queries in Design View before 
running them to find out what they do! 

 Double-click UpdateQuery to run again - why hasn’t it changed any data? 
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Task 12 Create a Parameter query 

Objectives To create a query that asks you what you want to see in the query results. 

Comments A parameter query is useful if you frequently run the same query but have to change 
the criteria each time you run it or of having lots of similar queries. Parameter 
queries ask you for the criteria you want to run the query against.  

 

Simple parameter search 

12.1 To create a query prompting you for a subject code: 

 Create a new query and add the Students table. 

 Add FirstName, LastName, Subject and YearNumber to the QBE grid. 

 In the Criteria row for Subject enter [Which subject?] (add the square brackets). 

 
Figure 46 – a simple parameter query 

Note    The text inside the square brackets is what will be displayed, asking what subject 
you want to search for (the text should not be the same as an existing field name).  

 Save the query and name it SubjectSearch.  

 Select Datasheet View and when prompted for a subject, enter L500 and click OK. 

12.2 To practice the above: 

 Remove the criteria from the above query. 

 Add a similar question in LastName field and search for Smith. 

Parameter and wildcard search 

Note    This uses the like operator, wildcard character * and the concatenation character &. 
See the Reference document for details of Operators (or use the on-line help). 

12.3 To create parameter searches using wildcards: 

 
Figure 47 – how this parameter search query should look in the QBE grid 

 Remove the criteria and type Like [Which Lastname?]&* (Figure 47). 

 Run the query and enter the letter s when prompted.  

 Look at the query results then return to Design View and add the Subjects table. 

 Add a wildcard search for CourseName, then close the query, saving it if you want. 
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Task 13 Using Forms 

Objectives To explore the forms in the Student database. 

Comments Forms are more convenient than tables for accessing and entering data. Forms let 
you look at data one record at a time and let you enter data consistently. 

 

What do I need to know about forms before I start? 

Question Answer 

What are forms 
used for? 

Forms are designed to make your data easy to look at and 
use. In particular, forms provide an efficient way to find, edit, 
and add data, such as through dropdown lists. They also let 
you look at one record at time and master detail. 

Are forms easy 
to create? 

It’s easy to create simple forms. More sophisticated forms 
require more effort but result in powerful and useful facilities.  

How many 
forms can I have 
in a database? 

Any number of forms can be developed within a database to 
look at or enter the data in different ways. For example, in a 
student database one form could relate to personal details 
(e.g. first name, last name, home address, term time address, 
date of birth), whilst another form could relate to academic 
progress (e.g. first name, last name, number of projects 
submitted, project mark, subject, tutor) of male students.  

Opening a pre-existing form 

13.1 To open an example form: 

 Make sure that you have closed all objects. 

 In the Forms section of the Navigation Pane, double click on StudentForm. 

Note    This form displays fields from the Students, Faculties and Subjects tables. 

 
Figure 48 – Student Form 
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Features on the Student form 

Feature Description 

Dropdown lists Subject and Title have dropdown lists – the values in Title 
were specified when the dropdown was set up (these can be 
amended or added to at any time) and the values in Subject 
come from the Subjects table. Dropdown lists reduce data 
entry time and typos as well as ensuring data consistency. 

Calculations Age is a calculated field – this field is not included in the 
Students table. It is greyed out to show it cannot be updated. 

Conditional 
formatting 

The Sex field changes colour based on the value in the field. 

Tabs Tabs let you group related fields together to save space on the 
main form. You can also include subforms and images on tabs. 
One tab here includes a crosstab form. 

Hyperlinks Links here open another part of the database and a web page. 

Record view In form view only one student’s data is viewed at a time.  

Images Images are added for each student and the form header 
includes a University crest visible on all records. 

Buttons Buttons can show text or images (the latter can show a helpful 
tip when hovered over). Buttons can be set up for many tasks 
(there is a course available to explore what buttons can do – 
see Access buttons and macros, CC2ABM). 

 

13.2 To familiarise yourself with the Student form: 

 Read through the above table and locate the elements on the StudentForm. 

 Click on the down arrow alongside the Subject field to display a list of subject codes 
and titles. 

 Select any subject from the dropdown list and notice the contents of the Subject 
window change to display the subject code highlighted in the list.  

 Try adding an unknown code, such as XYZ123 to see what happens. 

 Change the Subject back to H300 before continuing. 

Note    Only the Subject code is shown in the field: the subject titles in the list help you to 
choose the right code. You will find out later how to display the subject title instead. 

 Move between records using the navigation buttons in the bottom left hand corner of 
the Form window.  

Finding data 

Note    Finding a record using the Find button in form view is the same process as finding a 
record in table view. 

13.3 To practice finding specific records in form view: 

 
Figure 49 – make sure that Match corresponds to the above setting 
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 Click on the Find button and find Chelwood Village – make sure that Look In says 
Current document and Match says Any Part of Field (Figure 49).  

 Close the Find and Replace dialogue box. 

Switching between Form and Datasheet View 

It is possible to switch between Form View (which shows one record at a time) and 
Datasheet View (which shows records in a tabular format, similar to that in tables).  

13.4 To view records in Datasheet View: 

 Click on the downward arrow next to the Design View icon in the toolbar. 

 Select Datasheet View (Figure 50) and close the window when you are finished.  

 
Figure 50 - switching views from a form 
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Task 14 Create a form with subform using Form Wizard 

Objectives To create a form based on the Students table with a subform based on the Marks 
table. To understand the two different sets of properties associated with a subform. 

Comments The Form wizard gives you choices on fields to include and available layouts, thus 
allowing more flexibility than some other options. You can also, as in this task, use a 
wizard to create a form with a subform, though to do this there must be an existing 
relationship between the two tables used in creation of the form/subform. 

 

What do I need to know about subforms before I start? 

Question Answer 

How do I create a 
subform within a 
form? 

 You can use the Subform/Subreport Wizard in the 
Controls section within the Design tab of the Ribbon. 

 You can drag an existing form, query or table from the 
Navigation Pane onto an existing form. 

 You can create the main form and subform together by 
adding all the fields for both using the Form Wizard. This 
way, Access recognises a one-to-many link and uses the 
correct fields for the main form and the subform.  

Why do subforms 
have two sets of 
properties? 

Subforms have two sets of properties. One relates to the 
subform and the other relates to the relationship between 
the main form and the subform. 

Creating a form with a subform using Form Wizard 

14.1 To create a form with subform using Form Wizard: 

 
Figure 51 – select Form Wizard 

 In the Create section of the Ribbon, select Form Wizard from Forms. (Figure 51) 

 From the dropdown list that shows available tables and queries choose Table: 
Students (you may need to scroll up to find this on the list). 

 
Figure 52 – select the fields from the Students table as shown 
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 In the Available Fields box, double-click on StudentNumber, FirstName, 
LastName, YearNumber, Subject and DOB in turn to move them to the Selected 
Fields box, then click Next (Figure 52). 

 Now select Table: Marks from the Tables/Queries dropdown list. 

 
Figure 53 – select all fields except StudentNumber from the Marks table 

 Move all fields except for StudentNumber across to the Selected Fields box, then 
click Next. 

 Select to view your data by Students, if not already the default, and make sure that 
Form with subform(s) is selected, then click Next. 

 
Figure 54 – ensure the wizard screen is the same as above 

 Choose Datasheet as the layout for your subform, then click Next. 

 In Form change the suggested name to MyStudentForm and click Finish to see 
the form/subform you have just created (Figure 55). 
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Figure 55 – a very basic form with subform, ready to be customised 

 Notice that the data entry fields are different sizes, depending on their data type and 
the field size assigned when the tables were created. 

 Use the navigation buttons at the very bottom of the window (not those under the 
subform) to move between records – note that any marks you added for student 
numbers 2 and 3 earlier will shown in the subform when you move to those records. 

Form, subform and form/subform join properties 

Note    Every item on a form has a set of properties associated with it, which allow you to 
fine tune the way in which any object on a form will work. The form itself also has its 
own set of properties, as has the subform and the relationship between the form and 
the subform. You can view and alter all properties on the Property Sheet. 

14.2 To view the main form properties: 

 
Figure 56 – select Design View 

 In the Home tab of the Ribbon, click on the downward arrow under the View icon in 
the Views section and select Design View. 

 In the Tools section in the Design tab of the Ribbon, select Property Sheet. 

 Click on the square box in the top, left-hand corner of the main form so that a small, 
square, black box appears (Figure 57) and note that the Property Sheet shows the 
word Form under Selection type directly underneath the Property Sheet header. 
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Figure 57 – properties for My Student Form (circled) 

14.3 To view the subform join properties: 

 Click only once on the blue square box on the subform (if you only click once, the 
small, black box should not appear) and note that Property Sheet now says 
Subform/Subreport as Selection type with the name of the form in the dropdown 
box below. 

 
Figure 58 – click once for properties for the link between the main form and the 
subform 

 Click on the Data tab in the Property Sheet and look at the contents of the Link 
Child Fields and Link Master Fields. Access created this link between form and 
subform (Figure 59) based on the relationship that you set up earlier. 

 
Figure 59 – the fields that the form and subform are linked on 

Note    The child field relates to the link field on the subform (foreign key) and the master 
field relates to the link field on the main form (primary key). Remember that these 
are the fields that you linked together in the Relationships window earlier. 

14.4 To view the subform properties and change the source of a subform: 

 Click once more on the square, blue box in the top, left-hand corner of the subform 
so that the small, square, black box appears and note that the Property Sheet 
shows the word Form again as Selection type (Figure 60). 

     
Figure 60 - properties for the Marks subform 

 Close the Property Sheet by clicking on the icon in the Tools section of the 
Ribbon. 
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Task 15 Customising a form - basics 

Objectives To make the form look and work the way you want it to. 

Comments Customise a form by changing the appearance of text, data and other objects. 

 

What do I need to know before I start customising a form? 

Question Answer 

Can I alter the design in Form 
View? 

No. To alter form design you must be in Design 
View (or Layout View for simple changes).  

What is the best way to learn 
how to alter form design? 

The best way to learn how to customise the 
form is to experiment…and make mistakes! 

What do I do if it all goes 
horribly wrong? 

If it all goes horribly wrong, you can click on 
the Undo icon to undo your last action.  

What if it all goes horribly 
wrong but I don’t notice in time 
to use the Undo command? 

If it all goes very horribly wrong, or if you do not 
like what you’ve done, you can just close the 
form - but remember to select No when asked if 
you want to save changes. However, it is a 
good idea to save the form regularly after 
making changes that you do like. 

Moving and resizing 

There are several ways of moving fields, labels and objects (see table below). 

15.1 To change the appearance of a field, label or other object: 

 Click on the object once so that ‘handles’ appear. 

 Try each of the actions in the two tables below by using the method suggested (you 
must click on the object to select it first). 

 
Figure 61 – Moving the field and label together 

Action Method 

To move a field and label 
together (Figure 61) 

Move the mouse pointer over the edge of an object 
so that a four-headed arrow appears, then click 
and drag the box to a new position.  

To move a field without 
moving the label, or vice 
versa (Figure 62) 

Move the mouse pointer over the larger handle at 
the top, left-hand corner of the field control, then 
click and drag it to a new position. 

 
Figure 62 - moving one part of the field by clicking on the large ‘handle’ 

 



Using and designing Access 2010 databases (acc-29)  

 

 40  

Action Method 

To move selected controls 
with micro movement 

Click on a field control and press CTRL+ARROW 
keys to move in the direction of the arrow. 

To change the size of an 
object (Figure 63) 

Move the mouse pointer across the handles until 
a double-headed arrow appears, then click and 
drag to the required size. 

To size selected controls with 
micro movement 

Press the SHIFT+ARROW keys. 

 

 
Figure 63 – resizing a field (double-headed arrow) 

Formatting options 

Note    There are several ways in which you can customise your form, for example, there 
are a number of useful toolbar buttons available in Design View.  

15.2 To find out what the various toolbar options can do: 

 Click on the Format tab of the Ribbon, and look at the various options – some 
should be familiar as they are the same as those found in other Office applications. 

 Select a Text box (data field) and try changing the font and font size. 

 Experiment further on both fields and labels. 

 
Figure 64 - formatting toolbar 

 You can also format objects, such as field controls and labels using the Special 
Effect option by right-clicking on an object and choosing one of the options. 

 Have a look at the other options that you have on the right-click menu, especially at 
Align and Position, which can be quite useful (these options are also available on 
the Arrange tab in the Sizing & Ordering section). 
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Figure 65 – available Special Effects options 

Controls and adding new objects 

15.3 To add a title to your form: 

 
Figure 66 – the Controls section of the Ribbon 

 Click on the Design tab to view the options in the Controls section. 

 Click once on the label in the Form Header that says MyStudentForm and press 
DELETE on the keyboard. 

Note    You could just have altered the text in the original label, but then you wouldn’t have 
found out how to add a label! 

 In Controls, select Label by clicking once. 

 Place the mouse on the screen in the Form Header space (the cursor should 
change to +A – as in Figure 67), hold the mouse button down and draw a box. 

 
Figure 67 – the cursor changes to +A 

 In the label box, type a suitable title, alter the size and colour of the text (you will 
need to return to the Format tab) and resize the box if necessary (Figure 68) – you 
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will need to click outside of the box and then click once back on it before you can 
format any text that you have added.  

 
Figure 68 – the new form header label 

Note    Fields and labels can be deleted by selecting them and pressing the DELETE key. If 
you select the field and press DELETE, this will delete both the field and its label. If 
you select just the label and press DELETE, this will delete only the label. 

Format Painter 

Note    Formatting an object can take several or more operations. To do the same set of 
operations to each object in turn would be laborious so Format Painter lets you copy 
the formatting from one object to another object. 

15.4 To use Format Painter: 

 In the Format tab, click once on a data field and use the Fill/Back Color, Font/Fore 
Color and Line/Border Color options to change the colours of the background, the 
text and the text box in turn (Figure 69).  

 
Figure 69 - colour and border icons (circled) 

 Click away from the field (somewhere on the form, rather than on another object) 
and then click back on to the chosen field once to make sure that it is selected. 

 Click the Format Painter icon, and then select the next field to which you 
want to apply the formatting.  

 To copy the selected formatting to several locations, double-click Format 
Painter and then click once on each of the objects that you want to format.  

 Click Format Painter again to switch it off. 

Selecting and formatting multiple fields 

Note    You can select a number of fields at the same time so that formatting, sizing and 
alignment can be carried out in a single operation.  

15.5 To select multiple objects if they are located together: 

 Move to a point above and to the left of the first object, hold down the left mouse 
button and drag a rectangle down over the final object to be selected.  

 Release the left button and all the objects enclosed by the rectangle will be selected. 
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Figure 70 –selected objects are highlighted and display ‘handles’ 

15.6 To select multiple objects if they are not located together: 

 Click once on the first object. 

 Hold down the SHIFT key and click on the other objects once in turn. 

Aligning and sizing objects 

15.7 To align and size multiple objects: 

Note    All objects when moved automatically snap to grid to make positioning of objects 
more uniform. 

 Once you have selected several fields, select the Arrange tab. 

 Align the selected field controls to each other by selecting Align, then choosing from 
Top, Bottom, Left or Right as your form design requires (Figure 71). 

 
Figure 71 – the Align options 

 To make the fields uniform in size to each other, click on the 
Size/Space icon and select To Tallest, To Shortest, To Widest or 
To Narrowest as your form design requires. 

 Also use the Size/Space icon to experiment with the various options in the Spacing 
section (at least three vertically spaced controls should be selected for the Equal 
Vertical options). 

Note    If you get unwanted results, select Undo on the toolbar and try again selecting only 
the field controls and not the labels.  

 Look at how the form looks in Form View (Figure 72). 

Resizing and repositionsing the subform 

15.8 To resize and reposition the subform: 
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 Click on the Marks label to the left of the subform and press DELETE on the 
keyboard. 

 Click once and hold down the mouse on the subform and drag to the desired 
position. 

 Use the handles to resize the subform so that you can see all of the available fields 
in the subform. 

 
Figure 72 – how your form with subform might look 
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Task 16 Customising a form – more advanced methods 

Objectives More ways to make the form look and work how you want it to. 

Comments This task reintroduces the Property Sheet, which gives you fine control over how 
various objects look and act. 

 

Properties 

For several of the following tasks you will need to use the Properties box. As you 
become more experienced in fine-tuning the controls on your form, you will find that 
it is useful to keep the Properties box open whilst designing your form. 

16.1 To open and get to know the Properties box:  

 In Design View go to the Design tab of the Ribbon and select Property 
Sheet.  

 Click on one of the fields that you have formatted and select the Format tab to look 
at the options (Figure 73). 

 
Figure 73 - properties box 

 Now click on a field that you have not applied any formatting to and see how the 
values of the various options are different from the object you first selected. 

Note    If you do not have any unformatted fields, do the following and then repeat 16.1. 

16.2 To add another field to your form: 

 Select Add Existing Fields from the Ribbon to open the Field List 

Note    If you have forgotten to add a field when creating the form using Form 
Wizard, or if you have accidentally deleted a field, you can add these 
fields to your form. 

 Click on MiddleNames in the Field List box and drag it onto an empty part of the 
form. The field and label will appear on your form with default formatting. 

Note    Multiple fields can be selected by holding down the CTRL key whilst clicking the 
mouse on each field in turn. 

 Close the Field List then repeat task 16.1 to see the differences in the properties 
then delete MiddleNames from your form – unless you really want to keep it on your 
form, that is! 
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Locking fields and removing them from the tabbing list 

Note    For some databases, it is important that users should not be allowed to change the 
values of certain fields; a student reference number would be an example. This can 
be achieved by locking the field.  

16.3 To lock a field: 

 Make sure that the Property Sheet is open and click on the YearNumber field. 

 In the Property Sheet, select the Data tab and set Locked to Yes (Figure 74). 

 
Figure 74 – set Locked to Yes 

 Test out the locked field by looking at Form View and trying to edit the data in the 
field which you have locked.  

Note    You can also use the Enabled property under the Data tab to stop searching or 
entering the field, but this means that you cannot then use the field for sorting. 

Changing the order of data entry (tabbing order) 

Note    Pressing the TAB key moves from one data field to the next. However, if you have 
moved fields around in Design View, then the tabbing order is likely to be wrong.  

16.4 To change the order of data entry tabbing on the form: 

 In Form View, try TABBING from field to field and see if the order is odd. 

 In Design View, go to the Design tab and select Tab Order. 

 
Figure 75 - changing the tab order 
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 In the Tab Order dialogue box change the order of the fields by clicking once on the 
grey box to the left of the field name. 

 Click on the box (which is now black) again and drag the field to a new position in 
the list. 

 When the order is correct, click on OK. 

Note    The Auto Order option doesn’t always work as might be expected! 

Adding an image 

www.bristol.ac.uk/imagelib holds a library of corporate graphics which you can use. 

Note    Forms can include pictures, sounds and other objects. These can be stand-alone, 
unbound objects (i.e. the same object is shown on every record), or bound and 
stored in the underlying table (e.g. a photo of each student).  

16.5 To insert an image onto your form: 

 Save one of the images from the webpage (the easiest way is to right-click on the 
image and select Copy). 

 Right-click in the Form Header and select Paste from the menu that appears. 

 Notice that the picture is placed inside a box, which can be resized.  

16.6 To format the image to taste: 

 Resize the box and see what happens to the picture inside.  

 Open the Property Sheet if it is closed and select the Format tab. 

 
Figure 76 – Size Mode properties 

 Click on Size Mode and experiment with the options available from the dropdown 
list: Stretch shows the whole picture stretched to outline; Zoom shows the whole 
picture in proportion (Figure 76). 

 

http://www.bristol.ac.uk/imagelib
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Task 17 Add a dropdown box 

Objectives To add a dropdown box to the form, from which to select data from a linked table. 

Comments When you click on a dropdown box a list of values appears. Selecting the value 
enters it into the field. Not only does a dropdown box reduce the need for typing, it 
also helps to ensure accuracy and consistency of data. Combo boxes can use either 
values from an existing table (generally most useful) or values you type in yourself. 

 

 

17.1 To create a dropdown box containing subject codes and course names: 

 Make sure that you have MyStudentForm open in Design View. 

 In the Design tab of the Ribbon click once on the Combo Box icon.  

 Draw a box on your form roughly where you want the Combo Box to 
appear. 

 The values will come from another table, so accept the defaults and click Next.  

 From the list of available tables, select Table: Subjects and click Next. 

 Double-click on Subject and CourseName (in that order) so that they are added to 
the Selected Fields box and click on Next (Figure 77).  

 
Figure 77 – select Subject and CourseName as above 

Note    Subject must be chosen first because the first field chosen is the one stored later. 

 Sort by CourseName (leave the default as Ascending) and click Next. 

 If necessary, adjust the width of CourseName. Subject is not visible, which is what 
we want, so leave the key column hidden and click on Next (Figure 78). 

 
Figure 78 – leave the key column (Subject) hidden and adjust CourseName width 

 From the dropdown list select Subject and click on Next (Figure 79). 

 
Figure 79 – store the value in the Subject field in the Student table 



Using and designing Access 2010 databases (acc-29)  

 

 49  

Note    The Subject field we have chosen to include in the dropdown box is the primary key 
from the Subject table. The Subject field on the form in which we want to store the 
value is a foreign key in the Students table. 

 The wizard now suggests a name for your new combo box. Name it as 
SubjectCombo and click Finish. 

17.2 To test your new combo box and to tidy up some loose ends: 

 Click on Form View to try out your new combo box. 

 Check that the code in the Subject field changes when you select a new subject 
from the list. If it doesn’t change, then delete the combo box and run through the 
wizard again, as you will most likely have missed out on one of the above stages. 

 Delete the existing Subject field from the form if you don’t want to see both the code 
and the name of the subject.  

Note    Even if you delete Subject from the form, the combo box still updates this field when 
you enter data using the combo box because the control source is bound to Subject. 

 Change the name on the combo box’s label to Subject name, adjust the size and 
position of the combo box if necessary and once you are happy, save the form. 

 
Figure 80 – the contents of the dropdown box are arranged in alphabetical order 

Limit to List  

17.3 To prevent entry of items that are not included in a combo box’s list: 

 In the Property Sheet, select the Data tab and look at the default for Limit To List. 

Note    The default for this combo box is set to Yes already. This is because Access 
recognises that you are entering data into a field that is a foreign key, where the 
relationship demands referential integrity. If you defined the contents of the list 
yourself, this would default to No. 

Disallowing null values 

Note    Combo boxes always accept null values when Limit to List is set to Yes whether or 
not the list contains null values.  

17.4 To check the current default and disallow null values: 

 Open MyStudentForm in Form View and try giving a blank subject to a student. 

 Close the form completely (do not just minimise the form) and open the Students 
table in Design View. 

 Set the Required property of Subject to Yes to make sure null values are not 
accepted (Figure 81). (This is probably already set to Yes.) 
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 Close and save the table, selecting Yes and Yes on the warning messages that 
appear. 

 
Figure 81 – set the Required property of Subject to Yes in table Design View 

Note    You can only set this property from the table. 

 Reopen MyStudentForm and try to give a blank subject to a student. 

 

 

If you have time… 
1.4 To practice creating combo boxes: 

 Using the I will type in the values that I want option, add 
another combo box that enters values into the Title field on the 
StudentForm (e.g. Mr, Mrs, Miss). 

Note    You will have to add the Title field to the form from Add Existing 
Fields in the Design tab of the Ribbon. 

 Limit the combo box to only accept items from the list. 
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Task 18 Add a calculation to a form 

Objectives To add calculated fields onto a form. 

Comments You can use expressions and functions to add calculated fields to a form, including 
many of those listed in Access query language elements (acc-r4). You must use a 
Text Box to create calculated fields. Do not confuse the Text Box and Label options. 

 

A simple calculation 

18.1 To create a simple calculated field on the form: 

 In Design View, select the Design tab on the Ribbon and click the Text 
Box button once and let go. 

 Move the mouse pointer to where you want to add the text box on the form, then 
click and draw a small rectangle with the mouse button depressed.  

Note    The new text box will say Unbound because you haven’t yet told Access what value 
the new field control is to show. 

 Click in the unbound box and type =[dob] + 21 (Figure 82).  

Note    Calculations must always be preceded by = to indicate that it is a calculation rather 
than an actual value. 

 
Figure 82 – creating a simple calculation in a new text box 

Note    This uses the existing DOB field and a static number to add 21 days to the date of 
birth (days is the default value). 

 In the label box to the left type a suitable label. 

Warning!     Changing the label text does not alter the name of the text box. If you want to name 
the text box, this must be done via the text box properties – see 18.2 below. 

 View the form and change the date of birth to see what happens to the new text box. 

 In Design View change the calculation in the text box to =[dob]+[StudentNumber].  

Note    This now adds two fields together with the calculation adding the relevant student 
number to the date of birth in days. 

Using the previous calculation in a subsequent calculation 

18.2 To use the previous calculation in a new calculation: 

 In Design View click on the text box that you have just created. 

 Open the Property Sheet and select the Other tab, then look at the content of the 
Name field – it will be called something along the lines of Text21 (Figure 83).  

 Rename this field as YearPlus. 

http://www.bris.ac.uk/is/selfhelp/documentation/acc-r4/acc-r4.htm
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Figure 83 – rename the field as YearPlus 

Note    It is useful to give calculated fields sensible names so that you have a better idea of 
what the control is when trying to sort out tabbing orders – otherwise you will see 
unhelpful Access-generated control names in the tabbing order list. 

 Create a new text box from Design tab of the Ribbon. 

 Type =[YearPlus]+21 and check the result in Form View. 

 

If you have time… 

Conditional calculations 

Note    You can use the function =iif(expression, true, false) where 
expression is the criteria, true is what to do if the criteria is true 
and false is what to do if the criteria is false. 

1.5 To create a text box with a conditional calculation: 

 Create another text box using the Controls section from the 
Design tab and enter 
=iif([PaidFees]=no,”Fees still owing”,”Paid”) then check the 
result. 

Note    iif above is not a misprint and stands for if and only if. Also make 
sure that you enter the correct number of [ ] and ( ) and make 
sure that they are entered exactly as above. 
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Task 19 Using filters 

Objectives To create filters to find selected records when browsing the database. 

Comments Filters and queries are very similar in that they are ways of searching the database 
quickly. The main difference is that queries are useful when you know what data you 
are looking for, whilst filters are useful for browsing the database when you don’t 
necessarily know what data it holds. 

 

What do I need to know about filters before I start? 

Question Answer 

What is the difference between 
a filter and a query? 

One difference between filters and queries is 
the result. With a query you can specify the 
fields that you see for the given criteria. With a 
filter you see all of the fields for the given 
criteria. You cannot specify the fields or the 
order of the fields. 

What different methods of 
filtering records are there? 

There are four methods:  

 Filter by Selection 

 Filter by Exclusion  

 Filter by Form 

 Advanced Filter/Sort 

Which database objects can I 
filter on? 

You can create filters on tables and queries in 
Datasheet View and in forms and subforms in 
either Form View or Datasheet View. 

Does removing a filter delete 
it? 

Removing a filter does not delete it - it just 
does not apply it. When you save a table or 
form, Access saves the last filter. You can 
reapply the filter by clicking on Apply Filter. 

How do I find out if I have a 
filter saved? 

You can check if a filter is attached to an object 
by looking at the object’s properties.  

Can I break anything by using 
filters? 

Yes! Treat filters with care, especially Filter by 
Selection because it is very easy to modify the 
data by mistake.  

Selection filter on a whole field 

19.1 To use a Selection filter on a whole field: 

 Open MyStudentForm in Form View, noting how many records there are specified 
by the navigation buttons (you might find it easier to do this task if you go to the 
Datasheet View of the form – though if you want to do this there is an extra step 
involved – see Note below). 

Note    If your new form does not have a Datasheet View option in the Views section on the 
Ribbon, go to Design View and select the form’s properties (see 14.2 for how to do 
this). In the Property Sheet, select the Format tab and change Allow Datasheet View 
to Yes. 

 Navigate through the records until you find one where the student is, for example, in 
year 2.  
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Warning!     Do not type 2 in the Year field to find a record because all this will do is change 
whatever is in the field to a 2. You need to go to a record that already includes what 
you want to filter against. 

 
Figure 84 – the Selection filter option 

 Click in the Year field that contains the value 2, and then click on Selection and 
choose Equals 2 from the dropdown list (under the Home tab of the Ribbon).  

 Note that fewer records are displayed because only students in year 2 are 
displayed, and that Filtered is now highlighted in the Navigation Bar at the bottom 
of the window. 

 
Figure 85 – remove the filter 

 Click the Toggle Filter icon (Figure 85) to remove the filter and display all the 
records again. 

 Now look at the form in Design View and select the form (if you have forgotten how 
to do this, refer back to 14.2). 

 Having selected the form, open the Property Sheet, select the Data tab and look at 
Filter (Figure 86). 

 
Figure 86 – even though the filter has been removed, the form records the last filter 

Selection filter on only part of a field 

19.2 To use the Selection filter on only part of a field: 

 Return to Form View. 

 In Date of Birth, find a record where Date of Birth includes July and highlight just 
that word (Figure 87). 
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Figure 87 – select just the word July 

 Click Selection followed by Contains July. This will only show students born in 
July. 

 Do not remove the filter as the results of this filter will be used in the next task. 

Selection filter using more than one filter 

19.3 To use a Selection filter using more than one filter: 

 Use the filter from the previous task, showing all those with a birthday in July. 

 Click in the Year field where the record is for year 1 and click Selection followed by 
Does Not Equal 1 to display just those students who were born in July and who are 
not in year 1. 

 Remove the filter (Toggle Filter). 

Filter By Form 

Note    If you want to choose the values to search on from a list use Filter By Form. This is 
very useful to show you what values are in that field. It is also useful when 
specifying multiple criteria. 

19.4 To use Filter By Form: 

 Open the Students table (so that you can see a filter working from a table). 

 
Figure 88 – remove existing filter if necessary 

 Select Advanced followed by Clear All Filters to remove the previous filter.  

 Select Advanced again, followed by Filter By Form.  

 
Figure 89 – select Advanced / Filter By Form 

 Click each field in turn and notice the dropdown arrow that appears when you click 
in each field (Figure 90) – each individual value for that field is shown.  
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Note    You can specify the filter criteria by selecting the value you are searching for from 
the list for that field, or by typing the value or an expression into the field. 

 
Figure 90 – you can choose values from the dropdown list 

 Click on YearNumber and select 2 from the dropdown and apply the filter (Toggle 
Filter).  

 Remove the filter by selecting Advanced / Clear All Filters. 

19.5 To display surnames starting from “S” using Filter By Form: 

 Select Advanced / Filter by Form again.  

 Click in the LastName field and press the S key.  

Note    The dropdown list now starts at S so that you can now select the name you want 
without having to scroll all the way down from the start of the list. It is not possible to 
display only those students with surnames beginning with S by this method. 

 Choose Smith then apply the filter (Toggle Filter) then clear the filter (Advanced / 
Clear All Filters). 

19.6 To list only surnames that start with S: 

 Select Advanced / Filter by Form again.  

 Type S* in the LastName field and apply the filter (Access automatically alters what 
you have entered to Like "s*") (Figure 91).  

 
Figure 91 – this will find just those surnames that begin with the letter ‘s’  

19.7 To use another type of condition when using Filter By Form: 

 Clear all filters and in Filter By Form view enter >=1/1/72 in Date of Birth to find 
students born after 1 January 1972. 

 Apply the filter and view the results (Access automatically adds hashes to show that 
it recognises that it is looking for a date) (Figure 92). 

 
Figure 92 – this will find all those students born on or after 1 January 1972 

19.8 To find null values by using Filter By Form: 
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 Clear all filters and in Filter By Form view, select Addr3, enter is null and apply the 
filter to find records by those students with no value in Addr3 (Figure 93). 

 
Figure 93 – this will find all those records where there is no data in the Add3 field 

Note    If you specify values in more than one field, the filter returns records only if they 
satisfy all values. To specify alternative values, click the Or tab at the bottom of the 
window, and enter the optional criteria there.  

Filter records by using Advanced Filter/Sort 

Note    For complex filters use the Advanced Filter/Sort option. This lets you add all the 
filter criteria and the sort order in one step. 

19.9 To filter records using Advanced Filter/Sort: 

 Clear all filters and select Advanced / Advanced Filter/Sort to open the query grid 
(Figure 94).  

 
Figure 94 - opening the advanced filter 

 Add Year and LastName to the grid. 

 Add criteria to find students in Year 2, sorting by Lastname ascending (Figure 95).  

 
Figure 95 – creating an advanced filter 

 Apply the filter and view the results.  

 Return to the grid (Advanced / Advanced Filter/Sort), click on the Save 
icon above the File tab and save the filter as TestFilter. 

 Apply the filter again then clear all filters and close the Students table 

19.10 To load a saved filter: 

 Look in the Queries section of the Navigation Pane to find TestFilter. 

 Double-click on TestFilter to apply the filter. 

 Close TestFilter and then close any other objects that you still have open. 
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Task 20 Using and creating reports 

Objectives To explore the elements that make up an existing report and to create a report using 
the Report Wizard. 

Comments Reports let you display and print out data in an attractive format. Reports also let 
you group data together, such as, in the report that you will create, showing a list of 
all students taking each course under the course title. You can also include 
calculations on your reports based on numerical data.  

 

What do I need to know about reports before I start? 

Question Answer 

If I spot something 
wrong with the data in 
a report, can I edit the 
data in Report View? 

No. Data shown in reports is only for display. To edit the 
data you will have to edit the data in Table View or Form 
View and then run the report again to show the changes 
made in the underlying data.  

What is the report 
based on? 

As with creating a form, a report is based on a query or 
table. You cannot include fields in your report which are 
not in the table or query. You may find it easier to create 
any expressions in the query rather than in the report. 

Is the Report Wizard 
any good? 

Report Wizard may not produce exactly what you want 
but it is better than the alternative of Design View, 
which provides you with a blank page! The wizard 
comes into its own when it comes to grouping data and 
providing summary reports, graphs and labels. 

Isn’t this all a bit like 
hard work? 

The good news is that, just like fine-tuning a form, the 
more experience you get, the easier it becomes. 

Don’t I recognise a lot 
of this fine-tuning from 
form design? 

Yes – most report design modification is done in exactly 
the same way as when modifying a form, though you 
need to understand grouping levels in reports.  

Viewing existing reports 

20.1 To view an existing report: 

 
Figure 96 – right-click on the report to open a context-sensitive menu 

 In the Reports section of the Navigation Pane, right-click on StudentReport and 
select Print Preview. 

 Click on the report or use the Zoom icon (magnifying glass) to change the 
magnification and use the vertical and horizontal scroll bars to browse the report.  

 Notice that the report has a picture of the University crest and that the students are 
all grouped under the name and code of their course. 
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Figure 97 - the print preview toolbar 

 Use the various icons on the Ribbon (Figure 97) to look at the different ways of 
viewing the report, having taken into account the warning below! 

Warning!     Do not click on the Print icon! 

 Close the report by clicking on the Close Print Preview icon to return to 
the Database window.  

Creating a report using Report Wizard 

20.2 To create a report using the Report Wizard: 

 
Figure 98 – select Report Wizard 

 Click on the Create tab on the Ribbon and select Report Wizard. 

 Select Query: RegistrationQueryForReport as the object from which the data 
comes.  

Note    This query uses three tables so all the fields from those three tables are available to 
use for the report. 

 Include all fields except for Faculty and click Next (Figure 99). 

 
Figure 99 – select all fields except for Faculty 

 When asked how you want to group the data, select by Faculties (this should 
already be highlighted) and click Next. 

 On the next screen choose Next as we don’t want any additional grouping levels. 
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Note    You can select up to four grouping levels if necessary. Though note that you have to 
have relationships between tables set up, otherwise you would not be able to create 
any grouping levels – Access only knows what grouping levels are possible based 
on the relationships that have been set up within a database. 

 When asked what sort order you want, select CourseName in the first dropdown 
box followed by LastName in the second dropdown box (Figure 100). Don’t click on 
Next yet. 

 
Figure 100 – sort by Coursename followed by Lastname 

 Have a look at the Summary Options (these would normally put calculated fields 
and percentages onto your report) to see what is available (noting that Count is not 
included), though don’t add anything - we are going to add some ‘manually’ later. 
Click Cancel followed by Next. 

 Choose Outline for the look of the report and click Next. 

 Click on each style option in turn to see a preview: select Office and click Next (see 
note below). 

Note    Depending on setup, you may not see the above style option. 

 Name the report MyRegistrationReport and click Finish to preview the report. 

Note    The name you choose appears as the main header on the report and the name of 
the report. If the name already exists a suffix will be added to preserve both objects. 

 
Figure 101 – basic grouped report created using Report Wizard 

 Notice that the report doesn’t look particularly beautiful – but we will do something 
about this in the next task. 

 Close the report by selecting Close Print Preview - this takes you into Design 
View, which we don’t want to see quite yet, so close this view as well. 
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Task 21 Customising a report 

Objectives To understand the different grouping and sorting levels in a report and to improve 
the layout and design of your new report. 

Comments There is very little difference between Design View in forms and reports, so this 
section points out the main difference – different sections depending on sorting and 
grouping levels – along with a few other useful tasks. 

 

Note    Controls, such as text, data labels, calculations, etc., can be added, moved and 
sized, and font size can be changed, emboldened, italicised, etc. in exactly the 
same way as in Design View for forms. The Property Sheet has additional layout 
formatting capabilities. 

Look at the design of an example report 

21.1 To look at various aspects of the structure and design of a pre-existing report prior 
to working on your own report: 

 
Figure 102 – you will need to toggle between Design View and Print Preview 

 Open RegistrationReport in Design View and look at each of the items described 
in the table below – you will need to move between Design View and Print Preview 
to spot some of these. 

Aspect of 
report to view 

Description and/or ‘how to’ tips 

Lines  A number of extra lines have been added to make the design 
of the report more attractive. Lines can be added from the 
Controls section in the Design tab. 

Text fields Text fields containing expressions have been added to the 
report.  

Running total Consecutive numbers appear to the left of the student details. 
Notice that the numbering starts at 1 in each Faculty.  

Report structure 
and sorting and 
grouping levels 

Notice that where a form in Design View only has three 
sections, Form Header, Detail and Form Footer, here there 
are currently six sections, though one has no content.  
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 Look at =Now() – this can show the time and/or date depending on properties set. 

 Look at the =1 field in the Detail section – change the =1 to =5 and see what 
difference this makes when you look at the report in Print Preview.  

 Look at the =sum([fees]) fields in Faculty Header and Report Footer and note that 
different values are displayed in Print Preview depending on where the calculation 
is done.  

 Look at =”Page” & [Page] & “ of “ & [Pages] – [Page] is page number and 
[Pages] is total number of pages. 

Note    Other aggregate functions such as count and avg can be used – see the Access 
query language elements document (document number acc-4). 

 Play around with moving and sizing controls, and adding lines and text fields for a 
few minutes, just to gain some familiarity before moving on to redesign your own 
report in the following section.  

Report design structure  

21.2 To understand the design structure of your report: 

Note    There are more sections to understand with reports than with forms. Forms only 
have a Form Header, Detail and Form Footer. 

 Still in RegistrationReport (in Design View) look at each section, as described in 
the following table. 

Section Description 

Report Header This is only printed once at the beginning of the report 
and could be just a title or a cover page. 

Page Header This is printed at the top of each page (there is nothing in 
this section in RegistrationReport). 

Faculty 
Header 

This section is here because you grouped the report by 
Faculty when you went through the wizard. This includes 
all the fields related to faculty: it appears on the report as 
many times as there are faculties with students attached. 

Detail This section shows each student’s details repeated on 
for each faculty. 

Page Footer This is printed at the bottom of each page. 

Report Footer This is printed once at the end of the report and is often 
used to display grand totals and counts. 

 

 Look to see where and how the objects in these sections appear on the report when 
previewed then close the report. 

 Close the report and save any changes that you have made. 

Redesigning the report you created earlier 

You are going to add a new group footer section to your new report and then add a 
calculated field to this section. You will add a running total to sequentially number 
the students by faculty. There are then some suggestions that you can try for 
yourself, otherwise you can experiment as you wish with the redesign of your report. 

 

http://www.bris.ac.uk/is/selfhelp/documentation/acc-r4/acc-r4.htm
http://www.bris.ac.uk/is/selfhelp/documentation/acc-r4/acc-r4.htm
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Sorting and grouping levels 

21.3 To add a Faculty Footer to the report: 

21.4 Open MyRegistrationReport in Design View. 

 
Figure 103 – select Group & Sort from the Grouping & Totals section of the Ribbon 

 Amend the sorting and grouping properties for the report by selecting Group & Sort. 

 Notice (underneath the Design View window) that Faculty is highlighted to show 
that grouping has been set (you did this when you went through the wizard).  

 
Figure 104 – the Sorting and Grouping dialogue box 

 Click on More in the highlighted Group bar. 

 Change without a footer section to with a footer section. 

 Deselect Group & Sort in the Ribbon to close the Group, Sort and Total window 
and notice the new, empty section labelled Faculty Footer (Figure 105).  

 
Figure 105 – notice that a new Faculty Footer appears 

 Preview the report to see where this space now appears throughout the report. 

Running total 

21.5 To add a running total: 

 Return to Design View and click on Text Box in the Controls section of 
the Ribbon.  

 Add the text box in the Detail section of the report to the left of CourseName. 

 Delete the label, which will say something along the lines of Text39. 

 In the text box, enter =1 (Figure 106). 

 
Figure 106 – the new text box next to the Coursename field 
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 Look at the report in Print Preview and then return to Design View and alter the 
size and position of the text box if necessary. 

 Select the new text box and select Property Sheet from the Ribbon. 

 In Property Sheet, select the Data tab. 

 In Running Sum choose Over All and see what this does in Print Preview, then 
change to Over Group and check Print Preview again (Figure 107).  

 
Figure 107 – try the different options under Running Sum 

Counting students per faculty in the Faculty Footer section 

21.6 To add a calculation that counts the number of students in each faculty: 

 Create a new text box in the Faculty Footer section. 

 Enter =count(*) into the text box, change the label so that it says Total number of 
students, and preview the report (Figure 108). 

 
Figure 108 – new calculated field in the Faculty Footer 

Add more calculations 

21.7 To experiment with adding calculations: 

 Create a new text box (for each calculation). 

 Add the following calculations to a text box and note the different results, depending 
on which part of the report you place the calculation.  

Calculation Where to enter the calculation in 
Design View 

= count(*) Put this in the Faculty Footer and also 
in the Report Footer. 

= sum([Fees]) As above.  

= avg([Fees]) As above.  

= sum(iif(PaidFees=true,1,0)) As above. 

= iif([YearNumber]=5,”Final 
year”,”ongoing”) 

Put this calculation in the Detail 
section only. 

=[Fees]*1.6 This type of calculation can be done to 
convert £s to another currency. In 
Properties, change Format to show 
Euros. 
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Force a new page 

21.8 To force a new page after each set of faculty details: 

 Make sure that you are in Design View and that the Property Sheet is open. 

 Click on the Faculty Footer bar and click on the Format tab in the Property Sheet. 

 Change Force New Page from None to After Section and preview the report. 

 
Figure 109 – force a new page after each Faculty Footer 

Change the formatting and add objects to taste 

 Try changing the font size text and moving and resizing some of the controls.  

 
Figure 110 – try adding boxes and lines (circled above) to your report 

 Try using some of the features in the Controls section of the Ribbon to add, 
shapes and lines to separate data or some descriptive text of your own (you will 
need to click on the downward arrow to the bottom, right of the visible icons in the 
Controls section to see all options).  

 Remember that you can use text boxes to create expressions, so you can join fields 
together the same way as with both queries and forms, e.g. =[FullName] & " is in 
year " & [Year] (don’t forget to include = at the beginning of any expression or 
calculation). 

 Click on Print Preview to view any changes you make. 
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Task 22 Produce mailing labels 

Objectives To produce mailing labels with student addresses. 

Comments You need to remember to select the object from which the data is to come before 
you start the Label Wizard. 

 

22.1 To create mailing labels using the Label Wizard: 

 
Figure 111 – select Labels 

 Click once on the Students table in the Navigation Pane to select it. 

 In the Create tab of the Ribbon, click on Labels from the Reports section to open 
the Label Wizard. 

 For Unit of Measure select Metric and for Filter by Manufacturer select Avery. 

 For Product number, scroll down and choose Avery J8162, then click on Next. 

 
Figure 112 – select the options as above 

Note    You will find a list of codes starting with J, but the code you need is not amongst this 
batch – scroll down further and you will find another batch that includes the word 
Avery at the start. The code you need is amongst this batch.  

 Leave the font and formatting of the labels as it is and click on Next. 

 Add the fields listed in the following table by double-clicking on them in turn, making 
sure that you follow each field with the correct keystroke on the keyboard. 

Field to add Keystroke to use after adding field 

Firstname SPACE 

Lastname ENTER 

Add1 ENTER 

Add2 ENTER 

Add3 ENTER 

Town ENTER 

Postcode No keystroke required 
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 Check that the Prototype label looks the same as that in Figure 113. 

 
Figure 113 – the prototype label 

 Click on Next, then double-click on LastName to sort by surname and click Next. 

 Save the report as StudentLabels and click Finish to see the result. 

22.2 To customise the labels: 

 Click on Close Print Preview to view at the report in Design View (Figure 114). 

 
Figure 114 – view the label in Design View 

 Open the Property Sheet and click on Add1. 

 In the Format tab, look at the following properties: Can Grow makes all the data 
visible by wrapping it rather than truncating it; Can Shrink stops blank lines showing 
in the middle of the address when not all field are populated. 

 =Trim in the top field removes trailing and leading spaces. 

 Close the report. 
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Task 23 More table practice (optional task) 
 

Default date 

Note    If you have a date field in a table and you want to make it default to the current date 
when new data is added the Date() function can be used. 

23.1 To make a date field default to the current date in new records: 

 Open the Marks table in Design View and click on the SubmitDate field. 

 In the Field Properties at the bottom of the window, type Date( ) as the Default 
Value property. 

 Open the Marks table (save it when prompted) to see that existing values for 
SubmitDate have not been changed, but that today’s date is entered automatically 
in the new record row at the bottom of the table (this value can be overwritten). 

 Close the Marks table. 

Table Lookup using another table 

Note    Table Lookup is used to create a field with a dropdown list that looks up data from 
another table. A field that is created as a lookup field in a table is shown as a lookup 
field when looking at tables, queries or forms – so it saves effort to create lookup 
fields in tables rather than forms. 

23.2 To create a Table Lookup using another table: 

Note    If a relationship already exists between the current table and the table you want the 
Lookup Wizard to look up values in, you must delete the relationship before the 
wizard will work. Don’t forget to add the relationship back in once finished. 

 Open the Relationships window (in Database Tools tab) and delete the 
relationship between the Students and Faculties tables (right-click on the 
relationship and select Delete). 

 Close the Relationships window and save changes if prompted. 

 Open the Students table in Design View and click on the Faculty field. 

 In the Data Type column, select Lookup Wizard… at the bottom of the list. 

 The default is set to look up another table or query, so just click Next. 

 Select Table: Faculties and click Next. 

 Double-click on Faculty and FacultyName and click Next. 

 Sort by FacultyName and click Next. 

 Click Next again and name the lookup as Faculty. 

 Save the changes to the table and close it 

 Open the Relationships window. 

 Right-click on the relationship and select Edit Relationship.  

 Tick Enforce Referential Integrity and Cascade Update Related Fields then OK. 

 Open the Students table and see that a dropdown arrow appears when you click 
into the Faculty field. 

 Click on the arrow and select a different faculty. 
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Note    Once you have created a Lookup list field, if you add the field to a form, Microsoft 
Access copies its definition into the form so combo or list boxes are created 
automatically. If you change the definition of a Lookup or Value List field in the table 
after adding it to a form, those changes will not be reflected in that form. To correct 
this, delete the field from the form and then add it again. 

Table Look up using a specified list of values 

23.3 To create a Table Lookup using a specified list of values: 

 Open the Students table in Design View and click on the Title field. 

 In the Data Type column, select Lookup Wizard… 

 Select I will type in the values that I want and click Next. 

 Enter Mr into the empty cell and then add Mrs, Miss, Ms and Dr into the 
subsequent cells. 

 Click Next and name the lookup as TitleLookup. 

 Open the Students table and save the changes. 

 Click in the Title field and use the dropdown list to change some of the titles from 
Mrs to Ms. 

Table Lookup using values from the same table 

Note    The Lookup Wizard data type does not allow you to use the table you are currently 
changing. 

23.4 To create a Lookup box based on data held in the same table: 

 Open the Students table in Design View and click on the Sex field. 

 In the Field Properties, select the Lookup tab. 

 In Display Control select Combo Box and in Row Source Type, select 
Table/Query. 

 In Row Source type the SQL statement, select distinct sex from students order 
by sex to create a list box that lists the existing sexes entered so far in alphabetical 
order without duplication. 

Note    This can also be done on a form in Design View by right-clicking on the Sex field 
and selecting Change To. Select Combo Box. Open the Property Sheet for the 
Sex field and insert the row source as above. In query Properties set Unique 
Values to Yes. 

 Look at the result of your changes in Datasheet View and change one field to 3. 

 Select Records / Refresh and look at the contents of the dropdown box again to 
see that you now have three sexes available, 1, 2 and 3 (“3” could, perhaps, mean 
sex undisclosed).  

 Close the Students table. 
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Task 24 More easy queries (optional task) 

Objectives To provide more valuable query practice. 

 

The not operator 

24.1 To create a query using the not operator: 

 Create a new query based on the Students table and add LastName and Town to 
the grid. 

 In the Criteria box for Town, enter not Bristol to list all students not living in Bristol. 

Date expressions 

24.2 To use date expressions in a query: 

 Remove the criteria from the previous task and add the DOB field twice. 

 In the second DOB field change DOB to DOB+7 to add 7 days to the date of birth.  

 Change Expr1: to Next week: (don’t forget to include the colon). 

 In the next column type Next year:[Next week] +365 and check the query results. 

 In the design grid, right-click on the Field row for Next week and open Properties… 
to look at the display options under General / Format.  

 Select several and look at the way these display the date when you run the query. 

Using Functions 

Note    A function is a small program to perform a task and return a value. Refer to Access 
query language elements (acc-2) for a complete list of functions and examples.  

24.3 To experiment with using functions in a query: 

 Remove the two fields added during the previous task and enter left (FirstName, 1) 
in the first empty column to return the first letter of the field. Check the results. 

 In the next empty column enter strconv(Town, 1) to the grid and look at the results. 

Note    strconv capitalises the first letter of each word in the field. Thus, if the town field 
shows all values in uppercase, such as BRISTOL, it would now display Bristol. This 
is a very useful function for showing text consistently. 

 Change the 1, first to 2 and then to 3, and check the results each time. 

24.4 Remove all the fields from the grid and enter Max (Len(LastName)) to show the 
length of the longest surname. (If you don’t believe it, count the number of letters in 
Rumpelstiltskin just to check!) 

More Grouping 

24.5 To experiment further with grouping: 

 Start with an empty grid and add the YearNumber field twice and click on the 
Totals option.  

 In the second YearNumber column, change Group By to Count and enter >10 in 
the Criteria field to show all years with more than 10 students. 

 In the first YearNumber column (the one with Group By), enter >1 in the Criteria 
field to show all years above year 1 which have more than 10 students. 

http://www.bristol.ac.uk/is/selfhelp/documentation/docs-current.htm#acc-r4
http://www.bristol.ac.uk/is/selfhelp/documentation/docs-current.htm#acc-r4
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Task 25 More advanced queries (optional task) 

Objectives To use functions, create a crosstab query using the Crosstab Query Wizard and 
look at joins between tables in queries. 

Comments These tasks are especially useful for researchers and those needing to analyze 
data. Functions always need round brackets around the arguments. 

 

Finding a person’s age using a simple date expression 

25.1 To find a person’s age by using a simple date expression: 

 Create a new query based on the Students table and add the DOB field. 

 In the next empty field enter Date( )-DOB and look at the result of the query, noting 
that if you subtract two dates then you will get the difference in days. 

Note    Date() is today's date and must have round brackets because it is treated as a 
function even though it takes no arguments. Another function Now() includes time. 

Finding a person’s age using the Datediff function 

25.2 To find a person’s age by using the DateDiff function:  

 In the next empty field enter DateDiff(“d”,DOB,Date( ))/365.25 and look at the 
result of the query. 

 Change Expr1: to Age: (don’t forget to include the colon). 

Note    For further information on the DateDiff function, go to the Access user-support 
website at: http://www.bristol.ac.uk/is/computing/advice/software/packages/access/ 

Rounding (as well as basing one calculated field on another) 

25.3 To round numbers up and down to a whole number: 

 In the next empty field enter int(Age) and look at the result of the query. 

 Change Expr1 to Age rounded down. 

Note    int rounds the age down to the nearest integer. To round up add 0.5 to the age that 
is, int([age]+0.5).  

 Change Age rounded down: Int([Age]) to Age rounded up: Int([Age]+.5) and 
look at the result of the query. 

Date difference in months 

25.4 To calculate the age calculated in months rather than days type: 
Age in months:DateDiff("m",DOB,Date( )). 

Set properties on an expression 

25.5 To set properties on an expression so as to control the layout: 

 Right-click the Age column, open the Property Sheet and, in the General tab, 
change Format to Fixed and Decimal Places to 2 and look at the result of the 
query.  

Note    If the number of places is set to 0, the age will be rounded up. You must specify 
fixed format to be able to change decimal places shown. 
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Crosstab query using the Crosstab Query Wizard 

Crosstab queries show your data with row and column headings based on the 
values in two selected fields, and is a good way to summarise large amounts of 
data: for example, viewing the number of male and female students for each faculty.  

25.6 To create a crosstab query using the Crosstab Query Wizard: 

 In the Create tab of the Ribbon, select Query Wizard, followed by Crosstab Query 
Wizard, then click OK. 

 Select Table: Students and click Next. 

 Double-click on Faculty (depending on whether you have done a previous optional 
task, this field may now be named FacultyLookup) as the row heading (since it has 
more fields than Sex) and click Next. 

 Now select Sex as the column heading and click Next. 

 Click once on StudentNumber in the Field box and click once on Count in the 
Functions box and then click Next. 

 Name it StudentsCrosstab and click Finish to view the results. 

Customising a crosstab query using the QBE grid 

Warning!     If the crosstab query created above shows faculty names already, rather than just 
faculty code, then do not bother with this task.  

25.7 To customise the above crosstab query using the QBE grid: 

 Look in Design View and notice that there is now a Crosstab row and a Total row. 

 Add the Faculties table. 

 In the Faculty (or FacultyLookup) column, click in the Table row and use the 
dropdown box to change the table to Faculties.  

 Now click in the Field row change the field to FacultyName using the dropdown. 

 Check the result of these changes and notice the column heading. 

Outer Joins 

By default, when you link two tables in a query, only those records that have a 
corresponding value in the other table are shown. However, sometimes you may 
want to see records where there are no matching values. 

25.8 To alter the join relationship to show results where there are no matching values: 

 Create a new query and add the Subjects and Students tables. 

 Add CourseName from the Subjects table and LastName from the Students table. 

 Check the result and notice that there is a surname against every subject. 

 Double-click on the relationship line between the two tables in the query and select 
Include ALL records from ‘Subjects’… and click OK. 

 Notice that the relationship now has an arrow at the many end. 

 Look at the query again to see that for some subjects, no surname appears. This is 
because all subjects are now shown regardless of whether there are any students. 
There are no students studying unknown subjects because of referential integrity. 

Note    This query only works if there are two tables (or queries) being used. Any more 
tables (or queries) will result in an ambiguous query error. 
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Task 26 More advanced forms (optional task) 

Objectives To add a calculation, add a tab control and create a calendar on a form. 

 

Adding a calculation 

26.1 To add a calculation to a form: 

 Open MyStudentForm in Design View and add a text box from Controls. 

 In the text box, type =int((date( )- DOB)/365.25) to calculate age and view changes. 

Note    The = indicates that this is a calculation rather than an actual value. 

Adding a tab control to a form 

Note    A tab control avoids the need for long forms and is very useful when the data can be 
sub-categorised. For example, Student Form has the basic details of the student on 
the main form and then tabbed pages for address, photo, and summary statistics. 

26.2 To add a tab control to My Student Form: 

 Click once on the Tab Control icon in the Controls section of the Ribbon 
and then click once on the form where you want to place the control.  

 Highlight several fields then right-click on one of them and select Cut. 

 Click on the tab of the page where you want the fields to appear then right-click 
anywhere on that page and select Paste (you cannot drag and drop objects). 

 Double-click on the individual page tab to open the Property Sheet. 

 Select the All tab and change Name to Tab Page 1 and Caption to My New Tab.  

 Add a new page by right-clicking on the page tab bar and selecting Insert Page. 

26.3 To add a picture to a tabbed page: 

 Click on the Format tab in the Property Sheet and click the three dots next to the 
Picture option, to get a list of pictures. 

 Select a picture from the list and look at where it is inserted. 

Creating a calendar on a form 

26.4 To create a calendar on a form: 

 Create a new form based on the Faculties table and add FacultyName, Faculty 
and RegDate. 

 In Design View select Active X Controls from the Controls section of the Ribbon 
(you will need to click on the lower of the two downward arrows), then choose 
Calendar Control 12.0 and click OK. 

 Open the Property Sheet, click on the Data tab and set the Control Source to 
RegDate to display this date on the calendar. 

 Go to Form View and change the date on the calendar.  

 Click on the Record Selector bar to save the record and notice that the RegDate 
field changes.  

Note    You would not normally have both the field and the calendar - this is to illustrate that 
the field really changes. 


